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Introducing ID Flow

ID Flow is premier software for ID card design, production and data management.

This guide provides basic understanding of product components and how to get started.
This guide is a supplement to the Help Menu provided within the product. The built-in
Help Menu provides comprehensive configuration details for each dialog.
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Quick Start Options

Quick Start Option 1

ID Flow is preconfigured with several Workstation Profiles. These profiles allow users to
select an application that resembles their intended use. Profiles are configured with
sample badge designs, menu options and enrollment processes that are appropriate for
the application.

Configure Workstation (3]

Configure Workstation

Continue using the current workstation settings or =elect a profile to automatically configure this
workstation for a particular application.

(" Continue using the current settings

" Launch Setup Wizard

i §Loac| a pre-configured workstation profile§

‘Basic ID Card - lssue Center Description

Advanced ID Card - l=sue Center Enroll people and issue basic photo ID cards.
Employee ID Card - lssue Center

Contractor I Card - lssue Center

K12 Student ID Card - lssue Center

University ID Card - lzsue Center

Healthcare Card - Issue Center

Club Membership Card - Issue Center

Government ID Card - lssue Center

[¥ Show this dialog at start up Mext | Help ‘

The Basic group has six data fields and a single-layer card design. The Advanced group
has additional fields, including signature and fingerprint fields, and a multi-layered card
design. These card designs are linked to a sample database that includes four sample
records. The card designs, data and data fields may be modified.

To use a pre-configured profile to get started, click on the profile and click Next.

Getting to configuration

Configuration is done through the Setup button on the Main Menu or through the
Admin Menu. Only users with Administrative Rights can change settings. After clicking
Setup you may choose to configure Jolly Server Settings or Workstation Settings. There is
a shortcut next to the Cardholder Group that will go directly to the Cardholder Group

Properties dialog. The Record Center button takes you to the database view of all
records.

- Page 4 -
© 2012 Jolly, Inc. All rights reserved.

http://www.jollytech.com
Rev-2012-06-19



Y
JOLLY

Q Main Location - ID Flow - Card Issue Center
File Admin Help
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Record Center

g:g id flow powered by Jolly Technologies

Click on Record Center to see the fields that are pre-configured in the database.

Editing Card Design

Each Cardholder Group has an associated ID card design. To edit the card design, open
the Cardholder Group Properties, select the Card Printing tab and click Edit.

Cardholder Group Properoies =
Gmnersi | Fecord Lookup | Envolment [ Card Prirdrg | Loga and Reporiz |
Cardholder Group: [Basic I Card s W
Ea
_— =
Enrollment Acme Technologies |:| o
——— Eport |
Find Record ——
vt Fudes
I ity gt nses
FReport Centar Upsiate Fiscerd At byt
Margaret Birch I Updste record atter print
Diractor of Marketig =
_
Print
g
Record Center
Satup
2. id flow = = =

This will launch the card designer.

In the card designer, design objects may be moved and resized with the mouse, deleted
by selecting delete while the object is highlighted and edited by double-clicking on the
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object. Design Objects may be added using the design object toolbar on the left of the
screen and by drawing the approximate object placement on the card with the mouse.
To change the card size and orientation go to File -> Edit Page Setup. More details about
ID Flow Designer follow on subsequent pages.

After design modifications are finished click Exit and Save.
For more information, refer to the Card Designer section later in this document.

Other Settings

Use the Enrollment button on the Main Menu to enroll new cardholders. Modifications
to the enrollment process, record look up and logs and reports are configured in the
Cardholder Group Properties.

See records by clicking the Record Center button. Sample records may be deleted, but it
is suggested a new record be added first so that the data set is not empty.

User Accounts and Locations are configured in Jolly Server Settings and workstation
tasks are configured in Workstation Settings.

Quick Start Option 2

Select “Launch Setup Wizard” from the Configure Workstation dialog at start up or run
from the Setup menu.

Configure Workstation [E==]

Configure Workstation Global Settings

Continue using the current workstation settings or select a profile to automatically configure this Configure seftings that apply to the entire compamy_auch as V.IS\IOF
workstation for a particular application groups, locations, log options, user accounts, e-mail notifications, and

maore.

i Continue using the current settings

Configure Global Settings

Workstation Settings

Configure settings that apply only to this workstation such as allowed

Basic [D Card - Issue Center_ Description

rc.angd D Card - lssue Center 1 Enroll people and issue basic photo ID cards. tasks, local devices and more.

Employee ID Card

Centracter IO Card Center

K12 Student D Ca ¢ Center Configure Workstation Settings ‘
University ID Card Center

Heatthcare Card - o

Club Membership Card - Issue Center setup leard

Government ID Card - Issue Center Run the guided setup wizard to create a new visitor group and configure workstation

task settings
Run Setup Wizard
[v Show this dialog at start up Help

Name the cardholder group; then choose the database:
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Group Name Select A Database For My Cardholder Group
Enter a descriptive name for the group of people to whom you intend to issue ID cards. Some
examples are Employees, Contractors and Studen

Selnct ihe dninbase where Uy Canihnlder Genup recceds wil be sineed. Severnl pre-con figared
dainbnses are avaBnbis f0r yaur USA T you May Ese your Dum datkans
Enter a name for the new group:

Whal database would you Be lu use?
[y Cardholder Group

1% Lo ome of the pre-confgured detabssss incuded with D Flow]

1 Connect be my own dalbase

T it the dalabase connecton settings fom an existing design e

e |[ oo

Finish

cancel |

< Back | Hesxt >_1 Enian |

Select the card size and then click edit the badge design (see instructions below for ID
Flow Designer):

= Setup Wizsrd
My Cardholder Group 1D Card Template

e D

=
Confirm My Cardholder Group ID Card Design
¥ ® printing Seinct
nne 0f e pre-sefined tempimies 2« chek 0n Page Sefup in crease & custom tempinie

A preview of the ID card is shown below. If you would fike to modify the design, ciick on Edit Card
Design. When you are ready to proceed, click Hext
ot Coy. [ ] -]

Preview:

Pt Hase:

[enaa . eode card Sice |

Edit Card Design |
Find Tenypilate... |

Label 338nx 213

Papr 33 nx213in

Page Eengp

Canced

«Back Mot > Enian

e[| oo

Finish

Then configure each tab of the Cardholder Group and Workstation Settings:

Cardhobdes Group Propenties

[ Generat | Record Lockup | Ereoiment | Cord Printing | Logs and Reports |
Cordhiider Group

Erber a i ared sedeoct i pictrn Bl will deriify Bhis carchaskder group

Chrong Narte i D Cord Pacdurn e F
o Warkstation Task Settings (=23
s Enroliment | Find Record | Logs and Reports | Record Center
Cardbcider Dndakan — Appearance
Sandect the sataasn Bhal will contin she carahalder recorn

V¥ Shevw group image on Main Menu
Configre Background color:
Eiit Record Linycul
r

suggesind for

¥ Set welcome scrsen image:

Select
¥ fpply to sl sereens

IE‘tre’tch -

[ Erable on-screen keyhoard

¥ &llow users to hide on-scresn keyhoard

—- * Tazk will only be performed it configured in cardhalder group settings
o | Cancal ol

Ok | Cancel | Help
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Using ID Flow

ID Flow has been designed to simplify the day-to-day data entry and production of ID
cards. It allows the user to enroll new cardholders, lookup an existing record and view
reports of all actions that have occurred. The Record Center shows all database records
and their ID card design.

O
i
Record Center
Enroll Irecad fon Arre Sampi ASanend U svaiahio Beow
e | Gs | b | 2a |w r ™y
= p—
Lookup T — TT— : ...... -
T T— b
e —— . AN 1 VA 1 TR
Report Center - e fc—
N T — N
Cr—rE— @

Go To Record Center ‘

Card Issue Center is designed so that multiple locations may be networked through
sharing a central Jolly Server. For this reason, there are two types of configuration
settings: Jolly Server Settings and Workstation Options.

To Setup, select the setup button on the Main Menu screen or from the Admin Menu.
Only Administrators have setup ability.

Jolly Server Settings and Workstation Options

ID Flow is designed to run across multiple locations in a networked environment.
Shared settings such as cardholder groups and log data are stored on the Jolly Server
while workstation specific options are configured in Workstation Options and Devices.
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If ID Flow will be used in a standalone environment where it does not need to share
data with other workstations, it can use the Internal Jolly Server, installed as part of ID
Flow.

Installing Jolly Server

Jolly Server is installed separately from ID Flow. To install, run the Jolly Server installer
that was provided to you when you purchased the software on the target server or
workstation.

Connecting to a shared Jolly Server — Networking Multiple Copies

When networking multiple copies of ID Flow, install the Jolly Server on a central server
or shared workstation. All networked copies should point to the same Jolly Server.

To connect to a Jolly Server, select File > Connect to Jolly Server.

Jolly Server

Program data is stored in the Jolly Server. A standalone version is installed with the
software. You may connect to the full version ofthe Jolly Server, installed separately, for
enterprise level data sharing and reliability. The full version is strongly recommended for
sites with high-volume traffic or multiple installations.

Connect to: | Internal [default]

v Show at startup Ok ‘ Cancel | Help ‘

By default, the Internal Jolly Server is selected. When Internal Jolly Server is selected,
the software will operate in standalone mode.

To connect to a shared Jolly Server, click the Configure button.
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Jolly Server Connection Settil E

Program data is stored in the Jolly Server. Configure the connection to the Jolly Server below.

" Use Internal Jolly Server [default]
Store data in the local Jolly Server database installed with the software. Select this option if
you do not need to share program data with other workstations.

& Connect to Jolly Server

Connectto an external Jolly Server installation (installed separately). Select this option if
you intend to share data between workstations and for enterprise level performance and

reliability.
Connection Type: |SlandardJol\ySeNerConnemion j
Server Address |JU||y'Ser\.'e[

Examples: server.domain.com, 192.168.1.1

Set Login | Password

Cancel | Help |

Enter the name of the server or workstation where Jolly Server was installed.

Jolly Server Settings

Jolly Server Settings are settings that can be shared between workstations such as
Cardholder Groups, Locations, Logs and Reports, Security Policy and User Accounts.

ooy .. ==
gy Cardhokder Groups
e g ru o crar s ke o s
cardhoider datatase, (FO{FRM and recortng cotons

Locatans
| Logs and Reports

| carancicer Graups | [P

|Besic 0 Card
|E ) Ca

cose ] = ]

Settings for Locations, Logs and Reports Security Policy and User Accounts are obvious
when the dialog is open.

Cardholder Group settings work in tandem with Workstation settings. Examples: 1. In
order to capture a signature in the enrollment process, the signature field must be
defined in the cardholder group’s Enrollment tab; 2. In order to lookup a record by email
address, that field needs to be defined in Record Lookup tab; 3. In order to log the name
and titles of cardholders, those fields must be defined in the Logs and Reports tab.
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Jolty Server Scttings Cardnolder Geoup Properties
—————— Gerer | Fmcord Lockup | Ereoseert | Car bt | Loge snd Repert
Cabvory Cargnider Groups Rt s ' -
Each cardhotler groug s of cardhoklers Condraidar Groug:
cardheider database. program sad recortng optins. Erter 0 name and select o picture that wil kderdity thix cardhokder group.
Grougp Nane s 6 Cord i [——] et
E.mai tiotteanens - '1 —_—
Usar Accourss Carmhoicer Groups Provivw’ & | o
Basic © Card e
Emgioyes O Carg = Gmery
Advanced € Card
Coedrokine Ditatiatn
Unkveraiy £ Card
Contractor O Card = —— ]
Heathcass Uember Card — -
b Mamearani care et Joty Server Cweeins | conigae
Dirvernment [ Card T
K12 Studest U Carg el
=k ™ scrw e
Bew Eat Deee
Cose | Heg | o I P | e

Workstation Options and Devices

Workstation Options and Devices apply to only to a specific workstation. They include

selecting the location, cardholder groups available at the location, selecting which tasks
will be available to the user, configuring the tasks and capture devices, and selecting the
language to be used a this location. Tasks are configured individually through the task’s
blue hyperlink or together via the configure button:

CarFoicke Groupn
A P R T T CE W e T S
T lewen

i
T P s b s s Ty jan gy 4 el iy

Fatgrn
o

-

= g

bt fa podnd an
Lagrage

N B w4 b e e e

I |

=3
N T e W e

Py

P —
e ==
LiaCadon
e it s B A
S —— O —

0= I i
| e | =] [

on Task Settings

1| Enroliment | Find Record | Logs and Reports | Record Center
Appearance
¥ Show group image on Main Menu

Background colar:

-

¥ Set welcome screen image:

Select

Stretch -

[% Applyto all sereens

[ Enable on-screen keyhoard

T

* Task will only be performed it configured in cardholder group settings oK

| Cancel |

Help ‘
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ID Card Design

Each Cardholder Group has an associated ID card design. To edit the card design, open
the Cardholder Group Properties, select the Card Printing tab and click Edit.

Cardholder Group Propertses =
Gmnersi | Fecord Lookup | Envolment [ Card Prirdrg | Loga and Reporiz |
Cardholder Group: [Basic ID Card = ] | i
= Edt
_ - — =
Enroliment Acme Technologies D o
/ A—— Bt
Find Record ———
it Fudes
I~ Wity pirt ndss
Ry Cemtar Lipehate Rmcaord Afae Prid
- v
Margaret Birch Upaate record acher print
Director of Marketing
[
£rint © o0
LT
Record Center
Satup
29 id flow — — -

Design Screen

The design screen contains four toolbars: general items, alignment tools, design objects
and object formatting.

€ 1D Flow - [ID Cards - 1]
|| File Edit Add View Tools Window Help

DIE&HE «» & X 0O 8s& as [~ Show Layers [ Live Data ¥ Double Sided ¥ Show U ]
BalE Tl AT L BiTila jon B opil b e
=1 |-+ o =] el =1 [ =] [— =] fre ] ]

A General Ttems Object Formatting
L Alignment Tools
g
Q —— Design Objects
T] -

L4 ‘ R Pointer [Ld| InsertImage

[T} O | zoom Il | Insert 1D Barcode

(B2 \ Draw Line [&#]| Insert 2D Barcode

= [C]| praw Rectangle/Square  =| Format Magnetic Stripe
@ o Draw Ellipse/Circle @ Format Smart Card
) T | Insert Text 2)))| Format RFID Tag
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Cards are designed by selecting the design object on the left-hand toolbar and by

drawing that object’s area on the card with the mouse. After the area drawn the

object’s Properties dialog will appear. Click through the tabs to format the object.
[ File Edit Add View Tools Window Help

[NR= = ] A egdlaos I~ ShowLayers [ Live Data ¥ Double Sided ¥ Show LY

« how i S
a; 0o " [inches

< W [vo o[ foa ol

‘ 0 I z 3 4
P T [ [ [ [ 1.

0 -4, Image Properties @

Image | Properies | Border| Dimensions | Prine Condidon

Image Source

£ Fived image fiom file

£ Variable image o file o intemet
% Variablz image hom database

€ Image captured or selected at print-time

Datsbase Field

Select a database field that contains either the photo data of the exact
location of the image fle.

K|=|o|@l/|rl> &

o
@
»

—_ “warkPhone

e I RS HomePhone =
1B&#1| |- 5t MobiPhone E|
— i Emaléddizss
= <<FirstName>> <<lLas|| [
@ <<Agency>>
_)))) i E ok Cancel Help

Objects may be resized at any time and Properties dialog re-accessed by double-click.

Working with Text

ID Flow contains rich text editing. Regular text, database text, serial number, date and
time may be combined within one text box. Type with a keyboard or use the + Field
button for text selections.

[ el Mol =] = — =] e =
R o e gl B e g R B g ST
N = =
E| ' Test | Propestos| Bercer] Dimensioea | Prre Corsteon | .
s | [ P nryEEN[~-, B e~ =]
9‘ i 4 -Frsiiame - - [ Te——
T : Dept: <<Depaiment==>
[ B g remen g
‘[:!_l __ Rlmmosbalatatele Lt b L
||
Il |-
E' 8|0 ke At abunce it dat e st chck on ' ekl
ey Serial Number..
‘J| g Date... |
"), E Time.
”]! 5 | A S ||
I Symbel_
] Tab
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There are three types of text formatting: Text Box, Flexible Text and Circular Text. Text
Box will always place text within the bounds of the box drawn in the design: If larger, it
will auto-reduce in font size or word wrap. Flexible Text will maintain font size
regardless of the size of the box drawn. Circular Text formats text in a circle.

] 5 ] ]
<<FirstName>> <<LastName>>

= Dept: <<Department>> -
] a a |
Test ey
Lo Prepeiies | fodes | Densors | Pl Cornbton |
Sihe [Tt e =
[T
Teot Diaction Flesshin Test |
[CrederTee |
1 I WodWisp
¥ o feducs Fort Sue

[ ok | Coel Aoch Helo

Working with Layers

Like other quality graphical design tools, ID Flow uses a layered design approach. Layers
may contain different design objects of varying opacity. Using layers adds a rich depth
to design and creates highly secure cards.

To see the layers window click the Show Layers checkbox on the top menu bar. Layers
are added using the [+] button at the bottom of the window. Use the arrow buttons to
move layers above and below other layers. Click the Print checkbox on each layer to
format its print condition. The active design layer is highlighted blue.

<<First>> <<Lasts>
. =<Title>>

- Page 14 -
© 2012 Jolly, Inc. All rights reserved.
http://www.jollytech.com

Rev-2012-06-19



QO
JOLLY

Viewing Designs with Live Data

At any time the card design may be viewed with data by checking the Live Data button
on the top menu bar:

RO Tl s e,
W .
Al 1
Sl
i
ol
=L
% Lisa Johnson
wall | Director of Marketing
=]I%
; \||3 #3330000
" BTN

To view the full record set: go to File -> Database Setup or click the data icon on the top
menu bar:

B File Edit Add View Tools Window Help
[DEd| ootz x(a]za]

Working with Print Conditions

Design objects or design layers may be set to print only if specific database conditions
are met. Print conditions are set on the Print Conditions tab of the object’s properties
dialog. K Panel (Black Panel) and UV Panel are also set on this tab.

Rectangle Properties P

~— . )

Frint Condition |

Floundngssl Eorderl EiIII Dirmenzi

 Always print this object
= Do ot printthicobjsct

( & Print thiz object bazed on ]

[ Print in black [K.

[~ Print in ultraviole

|l Record Match Condition

Begin |Left Value | Condition |Right Value E

Database Field: Company Contains EText: Walmart

Ok I Cancel

G |
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Saving a Design

When you are done editing the card design, close the designer to return to the Card
Issue Center.

Enrollment Configuration

Users define the relevant workflow for enrollment. Available steps include Data Entry,
Photo Capture, Signature Capture, Fingerprint Capture and Card Printing:

Start Enrollment

Floase compiato the erealment form balow ard cickeat whan firished

Take Phote

Browse For Photo ..

Enroliment Successful

Signature Capture Fingerprint Scan

Piease 510 using e sonaare pac. Chok et wien you are dore

Thank yourfor enroling! Chck Print to pant your bak
Fizase place your thumb on the fin i ekl alld 0 pant your badge

wour fingeiprink and Men chok fand

: Print
S T

Sean

3. 4. 5.

To configure photo capture, driver’s license scan, signature capture and fingerprint scan
in enrollment, define the processes in the Cardholder Group Properties (Jolly Server
Settings), and then enable the options and configure the devicese in the workstation
settings:
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Workstation Task Settings (=5
e { "Enroiiment
<<<<<<<< Enroliment
W allow Enrollment
Information Capture
¥ Enable Card Scanner Scanner Optiores
¥ Enakle Camera® Camera Options
¥ Enakle Signature Pac* Signature Pad Options:
¥ Enahle Fingerprint Pac* Fingerprint Options
— Task will only be performed if configured in cardholder group settings p— ‘ cancel ‘ . ‘

The capture device specifications are configured by clicking the Options buttons in the
Workstation Task Settings.

Notes about capture devices:

ID Flow supports TWAIN and WIA compatible cameras. The ability to capture a photo
from within ID Flow and trigger the flash will depend upon the camera’s software. 1D
Flow is commonly used with web cams: When Microsoft WDM is invoked as the capture
source, four photos are captured and the best may be chosen.

E3

Capture Live Image

Live Preview Select Best Image

)
s)
- 34

)
)

— ) » IS [} ]
Video Source.. Wideo Fomat.. |
Ehait Captuis, ] l

Cancel | Help ‘

|

ID Flow supports Topaz and Interlink USB signature and fingerprint pads.

ID Flow support Card Scanning Solutions ScanShell 800, ScanShell 1000 and SnapShell
camera for driver’s license and/or passport scanning. It does NOT support the 800N.

Some device files and drivers may be found under “add-on modules” on the “Download”
section of the www.jollytech.com website.
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Record Lookup allows the user to quickly search for records. When multiple matches
occur a selection dialog is shown. Strict matching may also be used if desired.

Lookup Record
Please scan the badge or enter the 1D number and click Next

1D Mumber

Dan't know the 1D mumber? Completa this form fa look if up

First Name l—
(“Tasitame [Johmon |
Date of Birlh "—"'—‘

Record Found

The following matching record was found.

Edit ‘ Print ‘ View History ‘

L Select From Matching Records = F |
el [ il e ) s
4 FustMame Last Name Tile Deepartmend Diate of Bith Diiver's Licenae §
1 Lisa Jobrson Piesident Copunae
[T 2 James  Jokecon  Shippieg Manager Dishibution
H | 3]
| [100/Page =]
[ |

Photo
ames chnson
Department
Shipping Manager Distribtion
Date of Birth
Sticet Address

Postal Code

City State

_

- Acme Technologies

James Johnson
Shipping Manager

|E||

ID #102

Edit Card Design | Show Back Side

10z

To configure record lookup, first define the lookup fields in the Record Lookup tab of
Cardholder Group Properties dialog found in Jolly Server Settings. The options can be

further defined in the Advanced Options dialog.

Lo her Simas Fragarie: [=]

Ervainent | Carapvmtra | Loga wd Fenirts

4’ it J

Advanced Options @

Configure the advanced options for Record Lookug

[~ Mask ID number inpUt (characters will be replaced with * symbol);

™ Use strict matching - all information figlds must be complete
W Allovw user to select from muttiple matches

¥ Alloww user to select from a list of records

W Show activate card button

W Show deactivate card button

OK | Cancel |

Help ‘
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Report Center Configuration

Logs and Reports shows activity on all actions that occur in the product: when a record
was added, edited or deleted and when card was printed; by whom, at what time and
location. Custom logs may be designed. Reports may be printed, exported and emailed.

Logs and Reports

Salect & log o repor bk

Four fields from a cardholder’s record may be configured in the Logs and Reports tab on

the Cardholder Group Properties dialog. The Workstation Setting for Logs and Reports
makes the item available or not.

Record Center

Record Center is used for the management of records. Records may be added, edited,

deleted, printed and duplicated from this screen. The down-arrow button provides
additional options.
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File  Admin  Help

Record Center

The records found in the database are shown belowy,

Mew | Edit | Delete Print | = 13 =»|=4]| 7|2

Current Record 3

D Mumber

100 Selected Records »
Records b

First Name Last Mame Vi Coment Fecond

Margaret Birch e
Wiews Al Records

Date of Birth Department Capture Image...

3/3/83 Marketmg Edit Record Layout...

Title Edit Card Design...

Director of Marketing

)
]

tdodify Database Source..

QO
JOLLY

=8 HoR ==

Main Menu

T B i)

Duplicate Record

Wiew Log..,

Encode Card

Margaret Birch
Director of Marketing

10 #1m

Edit Card Design

Records may be viewed in single-record or spreadsheet view by selecting the buttons on

the right of the toolbar.

&) Main Location - ID Flow - Card Issue Center =Rl
File Admin Help

Record Center

Records for 'Acme Sample Basic' are available below. Main Menu

Mew | Edit ‘ Delete Frint ‘v| [« Toll ?I 5 JM =g

I~ # FirstMame LastName Title Department Date of Bith 1D Mumber Photo

¥ 1 James Tolstoy Shipping Manager Distribution 2411380 102

T 2 Daniel Belmont P Engineering Engineering 54171965 103

¥ 3 Lisa Johnzon  Directar of Marketing tarketing 34371983 100

¥ 4 Michele  Smith WP Sales Sales B/411971 101

Records may be batch printed, deleted and edited by checking the box to the left of the
record and selecting the appropriate action. Records may be sorted by clicking on

column headers.

The toolbar contains filter and sort buttons E,? . Filters are used to create data
subsets. Sorting allows for multiple field sort criteria.
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Configure a record filter 1o show only records that meet the spacihed cntena. To show all records,
chck Claar Filer. Record filters miry aiso be stored for future use

e

Qo
JoLLy

Bogin_[Left Value_ [Condition Right Vaiue

Lotobane Pkt DateOrfNih A

[Combing

End

Claar Fiker

Ok ’cmml] Halp |

Load Filter | Store Fiker As I

Sort Setup...

¥ Sart Records by Fallowing Fields

Sort an Field |Somng Order

Firsthlame

Ascending

Lasthame

;I Azcending

IDMumber
Firstame:

Title:
Department
DateDfBith

Configuring the Record Screen

ID Flow has drag-and-drop record screen formatting. Select Edit Record Layout from the
down-arrow menu on the Record Screen: Size and move fields with the mouse.

TR
Bt Layou
Fiek: | nateBirin x| ¥ vibie ™ Read-oniy ™ Aeguired Fieid
Capton: e of Brin g [oee =] [anove =l Dsta M- [iarmal 2
Formst [Duio aod Tew v] 7 pate.  [700%9 ree [ B |
™ Save Formatied Data Dataul Viskie -
o sumier
(T |
e Acme Technologies
’h:‘n-nﬂ |, I
' = grYE—— '
poezan | : President '
| SE—— ] |
r = |
s @ |
| TN A O

Advanced Field Formatting

ID Flow Premier Edition contains advanced field formatting.

Fields may be made

Visible, Required and Read Only. They may be given default values. Drop-down lists
may be created. Text can be set to Capitalize, UPPER CASE or lower case. Image paths

may be created to store variable images to file.
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#] Custornize Layout

Edit  Layout
Field: | Date0 fBirth x| ¥ visible [~ Read-only [~ Required Field
Caption: [Date o Birth [ K [Bo ] [above |
Format: |pate and Time  ~| v Date: 720109 ~| [T Time:
[~ Save Formatted Data Default Value: -
Proto
100 = | ‘

Configuring Language

ID Flow is available in 10+ languages. Select the language in the Workstation Settings. A
translation table allows the user to make changes to the translation or to translate into
a language not yet provided by Jolly. After changing languages, restart the program.

Translation Text E’@
[ — File Find
Enter translated text in the right-hand column. Special tags must be entered exactly
Locadon as in the English version.
T P A e T e iy
P L I - sl |2 =
Cibkon Citupel English Norwegian a
e e Lt L] 2053 Sorting Order Sortering Bestil
bl i L 2054 Source &Table: &Source Tabel:
I 2055| Source file: <<none selected>> Kilde: =<ingen adresse valgt>>
2056| Spacing Avstand
2057| Spanish Spansk
. 2058| Specia&l Conditions: &Spesielle betingelser:
Taida 2058 Special Charactedr 8Special Character
e B dapan b bn o o wwame Ty jan gy o ten sy Eanigry | 2060|SpecificDate  |Bestemtdato
e 2081 Specify a title for the data block and how Angi en tittel for data blokk og hvor ofte biir
- =, often the user is prompted for a new piece |brukeren bedt om en ny brikke av data
3 & 05| SPecily a tte for the image and how often | Angi en tttl for bildet og hvor ofte bir
the user is prompted for a new image while | brukeren bedt om et nytt bilde under utskrift
=0 i 2063| Specify Criteria Angi Kriterier
R . il v B 2064| Specify Criteria (CTRL = F) Angi kriterier (CTRL = F)
2065| Specify Page And Press Enter Angi siden og trykk ENTER | |
Latpae 2086| Specify rotation angle for the text Angi rotasjen vinkel til teksten
P S T P 2067 | Specify SOL &Expression & ifiser SQL-uttrykk
T agaa =} |Speclfy the text to search and press Angi teksten du vil seke og trykk <ENTER= &
7 tans T 2088| ENTFR: tn start search tarte sakat
o % Import Export Save Cancel Help
iaml T ey R . | e i | s

The information contained in this document represents the current view of Jolly Technologies on the issues discussed as of the date
of this publication. This paper is for informational purposes only. Jolly Technologies makes no warranties, express or implied in this
document. Jolly, Jolly Technologies, ID Flow, Lobby Track, and Command Line Utility are either trademarks or registered trademarks

of Jolly, Inc. in the United States of America and/or other countries. The names of actual companies and products mentioned herein
may be the trademarks of their respective owners.

IDWholesaler

We know ID. It’'s what we do.

e www.|DWholesaler.com
retailer

TOP (800) 321-4405 x2
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